SHORT SHARP TRAINING
(monthly) issue 1206

Welcome to this issue of the Vectorworks Short Sharp
Training (monthly). This manual is designed to work like a
user group meeting. There is a main workshop topic, then
extended movies showing tips or techniques and an area
for beginners.

Workshop Topic
Referencing

Referencing in Vectorworks is the ability to link your current
Vectorworks file to an image, PDF, or another Vectorworks file. What
makes this so special is that when you update the original file (image,
PDF, or Vectorworks drawing) you can then update the link file.

The referencing concept allows you to divide your work with other
people to speed up the drawing process. This manual will cover the
basic concepts of referencing image files, PDFs, and the techniques
for referencing Vectorworks files.
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Introduction

cadmovie823

Referencing is where you link one file to your current Vectorworks file.
There are several options with referencing. You can reference an image
file, a PDF, or another Vectorworks drawing. When you reference between
Vectorworks drawings, you have several options how to link these files.
This manual will cover the basic concepts of referencing image files, PDFs,
and the techniques for referencing Vectorworks files.

Why would you want to do this?

Large projects often need to have several people working on them.
Referencing will allow you to have several people working on a project,
they can link their files together and they can see when others have updated
their drawings.

reference

Master File Source File

You might also be a sole practitioner that needs to import files from a
consultant. For example, a landscaper might need to import drawings from
an architect. The chances are that the drawings will change as the project
develops, so you need a process that will save you a lot of importing into
your project. Referencing allows you to set up a link to the imported file of
the architect. When you get the revised drawing, you only have to update
the linked file, as the main file will be updated automatically.
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The concept of Referencing sounds simple. You link two files together and
when you update one file you can see the changes in the other file. If you
use Referencing correctly it is simple and robust. However, there are some
pitfalls with things you should not do and some things to keep in mind that
make Referencing easier.
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Referencing Layers

Layer names are very important. You can not have two linked layers of the
same name. This means you can’t have the same layer name in the target
file and in the source file.

This layer cannot be

referenced, the layer
name already exists
in the target file.

When you Reference you can link several source files to the target file. The
source files can not have the same layer names. An easy solution is to have
a prefix on the layer names in the source files.

©Jonathan Pickup - http://www.archoncad.com Page 6
SHORT SHARP TRAINING - Issue 1206



Things to Watch Out for - Symbols

Symbols have to be carefully controlled. You can use symbols of the same
name in the target file and source file. However, the symbols have to be
identical.

For example, you could Reference three buildings to the site plan. Each
building might have a door symbol called DO1. As you Workgroup
Reference each building to the site plan, the door symbol DO1 will be
replaced by the new symbol DO1. It works well if you want all the symbols
with the same name to be identical, but it is a disaster if someone has used
this symbol name for something different, say a door elevation.

Door Symbol

DO Door Symbol

DO1

<

This door symbol
DO1 will replace
the symbol in the
target file, because
the name is the
same.

One way to manage this is to have clear symbol naming convention in your
office. Make sure people know what they can do and what they are not
allowed to do.
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Site & Symbols
Plan

Separate Building
Files

The other method to control this is to have a Reference file that contains all
the standard or common symbols. Each new building project references to
this file and hence all standards and symbols are kept consistent.
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Things to Watch Out for - Circular References

Do not create circular references, i.e. do no link two files in both direc-
tions!. That is, do not connect two files together in both directions (back
and forth). Does this make sense? How about: do not Workgroup Reference
File A to File B, then reference File B to File A.

In the example above, once you have linked the buildings to the site plan,
do not link the site plan to the buildings. Vectorworks will accept it, but it
may cause troubles later on with circular referenced symbols.

Another problem with circular references is that both file will both display
the same information. For example, if you reference the floor plan to a site
plan, and then you reference the site plan back to the floor plan, on the
original site plan you will see a duplicate of your site plan. This duplicate
will be rotated and relocated to suit the floor plan.
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Reference Options - Design Layer Viewport or Layer?

When you link files together you have two options. With Vectorworks
12 you can only link layers. Since Vectorworks 2008 you can choose to
use Design Layer Viewports to reference files. The problem with the
Vectorworks 12 mode (layers) is that the linked layers appear as design
layers. I have had several clients trying to work on the linked layers, only to
find that the information is lost when they update the Reference.

Design Layer Referencing

(_‘ any of these

layers can be
the referenced layers referenced
appear as design layers

in the file

The Design Layer Viewport mode allows you to see the referenced layers,
but you cannot edit or make changes to them directly. This process avoids
confusion and makes it clearer where the data should be edited.

Design Layer Viewport Referencing

- choose which layers to reference
- crop the reference
- edit which layers are referenced
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Absolute Path/Relative Path

When you reference files into your current Vectorworks file, you have to
decide whether to use absolute or relative path names.

The absolute path for your reference is the name of your computer
followed by the directory structure (folders) and finally to the actual name
of the file. This can work in some situations, but it does not work if you
have to move the file to another computer, or if you are storing it online
and other people want to share it.

The relative path is the location of the referenced file relative to the current
Vectorworks file. This works extremely well when the two files are in the
same folder. If you copy this folder to another computer, the files are still
relative to each other and so the references will not be broken. For most
situations it is best to keep all the referenced files together and use relative
referencing.
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Referencing Image Files

cadmovie824
Image Files
Vectorworks
drawi
image file rawing

When you import an image file you can choose to have the image file
placed directly in the drawing, or you can choose to reference the image
file. Why would you prefer one method over the other?

If you are working with others and they are updating the images files,
referencing the image files would allow you to update the images files
easily.

You can import image files by using a menu command or you can drag and
drop the files into your Vectorworks drawing. You will still be allowed to
reference files if you use drag-and-drop.

¢ Go to the Menu bar.

* Choose File > Import > Import Image File...
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New... #N
Open... ®0
Open Recent »

Close BW
Save EN
Save As...

Save A Copy As...

Save As Template...

ev
Batch Convert...
Send to CINEMA 4D (3D only)...

Document Settings »

Import Single DXF/DWG File...
Export » Import DXF/DWC...

Page Setup... X Import EPSF...

Print... Import Image File...
Import PICT...

Import PICT as Picture...
Import Worksheet...
Import VectorScript...

Import IGES (3D only)...
Import SAT (3D only)...
Import Parasolid X_T (3D only)...

* Navigate to the image file you want to import.

006 Import QuickTime Image Document
[« »|[EH = m]| [ (1206 Referencing BEA
FAVORITES .
SHARED ===
|
DEVICES
~1206 creating 1206 Creating Vectorworks image001.png
MEDIA vect~xeqmat.idik References.indd
Vector-workout Notes Vector-workout Notes
(page 23).png (page 24).png
&
Vector-workout Notes Vector-workout Notes Vector-workout Notes
(page 25).png (page 26).png (page 27).png
Vector-workout Notes Vector-workout Notes Vector-workout Notes
| Cancel | | Open

* Double-click on the image file you want to import.

If you drag and drop an image into aVectorworks file or if you use Import
Image File... you will see this dialog box. This dialog box allows you to
turn on the referencing of the image.

* Click on the Reference option.

* If you have saved your file, and your image file is in the same folder as
your Vectorworks file, then Vectorworks allows you to select Path
relative .... otherwise only the Absolute path option is enabled.
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Image Import Options

Image Information

File: image052.png
Format: 24-bit, 987 x 721, PNG image
Uncompressed Size: 2087 KB

Compression Method

(#)IPEG 227 KB
(_JPNG 1448 KB

Import As Black and White

¥ Reference

(=) Absolute path
(_ Path relative to current document

|_|Save referenced cache to disk
@Automatically update out of date reference during file open

[Canest |

* References are shown on the last tab on the Navigation palette. When
the original image is updated and saved, Vectorworks will use the
navigation palette to show that the referenced file is out of date.
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(6 H B A
Referenced File & | File Type Status
image052 g image Out of date

L

* To update a reference, right-click on the reference in the Navigation
palette.

* From the contextual menu, choose Update.

(«* 8 @ HZ B
Referenced File A | File Type Status
image052.ane Imane Out of date

New...
Edit...
Delete...

Upd

Update AH!
Open
Details...

Select All

When you choose update, Vectorworks will import the image file again.
Any changes made to the image file will now be visible.

©Jonathan Pickup - http://www.archoncad.com Page 15
SHORT SHARP TRAINING - Issue 1206



©Jonathan Fickup - http://www.archoncad.com Page 16
SHORT SHARP TRAINING - Issue 1206



Referencing PDF Files

cadmovie825

As with image files, PDF files can be drag-and-dropped into a Vectorworks
file, or you can use the Import PDF... command. In either case when you
import a PDF file, you have the choice of whether to import the file directly
or whether to reference the file.

If you are certain that the PDF will not be updated you can import the file
directly. But if you are working with a structural engineer for example, the
drawings might get updated due to unforeseen circumstances. So for
importing consultants drawings, it is better to use referencing.

Another good example is when you want to import general construction
notes. Many people have the general construction notes in another program
such as Pages or Word. Both of these programs allow you to export as
PDF. In Vectorworks you can then reference your general notes from the
PDF files. Whenever you update your general construction notes in your
Pages or Word document, you only have to save the PDF again. Next time
you open your Vectorworks file it will load the latest general construction
notes.

* Set the scale of the layer to the same scale as the PDF file you want to
import.

* Go to the Menu bar.

e Choose File > Import > Import PDF...

©Jonathan Pickup - http://www.archoncad.com Page 17
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New... #BN
Open... #®O
Open Recent »

Close BW
Save S
Save As...

Save A Copy As...

Save As Template...

Revert To Saved

Batch Convert...

Send to CINEMA 4D (3D only)...

Import Image File...

VAA Revise Issue Print...

Import PICT...
Import PICT as Picture...
Import Shapefile...

Document Settings »
[T Import Single DXF/DWG File..

Export »  Import DXF/DWG...

Issue Manager... Import IFC...

Page Setup... TEP

Print... wp Import PartSpec...

Batch Print... Import EPSF...

ol

* Navigate to the image file you want to import.

000 Import PDF

<« » |l = @) | (1206 Referencing 3@

Cancel

e Double-click on the image file you want to import.

If you drag and drop a PDF onto your Vectorworks drawing or if you use
Import PDF... you will see this dialog box. This dialog box is where you

choose to create a reference to the PDF.

e Click on the Reference option.

 If you have saved Vectorworks your file and your PDF is in the same
folder as your Vectorworks file (recommended), then choose Path
relative to current document. Otherwise, choose Absolute path.

©Jonathan Fickup - http://www.archoncad.com
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Import PDF

Import Range
(s)Pages from: 1 to: 1

All Pages (1)

\21 Reference

Absolute path
(=) Path relative to current document

Save referenced cache to disk
Automatically update out of date reference during file open

Cancel | | Import |

* Click on the Import button.

Your PDF file will now be imported into your drawing. If you choose to
import more than one page from your PDF you will see several PDFs
stacked one on top of the other.

U]
—

* You can now move your PDF files and even rotate them. They will
remain linked to the original PDF.

©Jonathan Pickup - http://www.archoncad.com Page 19
SHORT SHARP TRAINING - Issue 1206



e When you receive updated drawings from your consultant, store these
drawings with the same name, in the same location as the original PDF
files referenced.

* When you check the Navigation palette, you will see that your
referenced file is now out of date.

(=5 & HEE-
Referenced File & | File Type Sta)

staircase_ga. pdf PDF Out

L

* Right-click on the out of date referenced file and choose Update.

©Jonathan Pickup - http://www.archoncad.com Page 20
SHORT SHARP TRAINING - Issue 1206



{5 & BEBED-
Referenced File & | File Type Sta
staircase_ga. pdf _— Out

New...
Edit...
Delete...

Updategil
Open
Details...

Select All

 This will update the referenced file.

Another instance can occur when the consultant changes the name of the
drawing, e.g. because of substantial changes. You can now use the Naviga-
tion palette to edit the already linked reference file to the new drawing.

* Go to the Navigation palette.
* Right-click on the referenced file.
* Choose Edit...

{5 & EBFED
Referencad File & | File Type Sta

i Uy
staircas New... p

[ Ee
Delete’®
Update

Update All
Open

Details...

Select All

¢ (Click on the Browse... button.
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Edit Reference

Source File

.:staircase_ga.pdf —Buwn.,FJ

Save reference location as:

| Absolute path
(=) Path relative to current document
Save referenced cache to disk
Automatically update out of date reference during file open

To change the document being referenced, click this button. Only do this to select an
aitemate version of the present document, nat a completely different one.

Cancel | [ OK |

* Locate the new drawing.

N O Open Current-Version Drawing
B = @ (] 1206 Referencing = (@
TS image016.png image017.png image018.png
SHARED
DEVICES =
MEDIA FOF
image019.png image052.png staircase_fab_1_of_3.pd
PoF =
staircase_ga.pdf Vector-workout Notes Vector-workout Notes
(page 23).png (page 24).png
Cancel | [ Ogen |

* Double-click on the new file that you want to reference, or click on the
file once and then click on the Open button.

Edit Reference

Source File

.:staircase_fab_1_of 3.pdf Browse...

Save reference location as:

_ Absolute path

Path relative to current document

Save referenced cache to disk

Automatically update out of date reference during file open

Cancel | [ OK |
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The previous PDF file will be replaced by the new one. If you have used
the PDF to create viewports, they will also be updated.

©Jonathan Pickup - http://www.archoncad.com Page 23
SHORT SHARP TRAINING - Issue 1206



Referencing Three Buildings onto a Site

The first step in setting out a project is to decide on areas of responsibility.
You can not have every team member working on all parts of the project,
so decide who will be working on which part. Then each person has a part
of the project as a separate file. The more people you have on a project the
more files you need.

In this example we have three separate buildings on one site. An easy
way to sort out responsibilities would be to have one architect in charge
of all the drawings for each building. This example will not need a lot of
Referencing to link the buildings together, but there will be a small amount
of referencing to get common symbols and details for each building, and a
reference from each building to the site plan, where you want to show the
latest building outline on the site plan.

uilding 1

g

7

Site Plan Common symbols

and Details

uilding 3
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Stage 1

Set up the common symbols for these buildings. You don’t have to set up
the details yet, but setting up some common symbols will save time for all
members of the team.

Common symbols
and Details
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Stage 2

Start three drawing files for the three buildings. They can all reference to
the common symbols for doors, windows and so on from the common file.
That will save them time and maintain consistency.

As the three buildings develop and move into detailing, the standard details
can be drawn in the common file so each building can reference them. This
will save each architect time, and it will save errors in the drawing, because
the details are only drawn once.

00 Havigation

uilding 1

=

i

Common symbols
and Details
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Stage 3

At any time you can link the three Buildings to the site plan. You can
choose which stories of the building to reference, and once referenced you

can move them around on the site plan.

This is a different way of organising the drawings. By having all the
drawings separated into three buildings, you have lost the ability to have

one person responsible for drawing issues.

S

.

Site Plan

Common symbols
and Details

If you wanted to have one person to be in charge of all the drawings, you
could slightly change the organisation of the files. This would let each
architect create all the information for the building, then reference this to

the contract documentation set.

©Jonathan Pickup - http://www.archoncad.com
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Site Plan
and

Contract Documents

=

<

\\
\/ V
Common symbols
8 and Details

Later versions of Vectorworks allow you to print all drawings from one
folder, which avoids the issue of having to print all the drawings from
different files. This means that you can still have one person responsible
for printing all the drawings but you would not have to put all the drawings
into one single file for that to happen.
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Referencing 1 - Large Building

cadmovie&26

This demonstration is only a quick look at Referencing a large building. If
you require detailed help, please contact me directly.

The first step in setting out a project is to decide on areas of responsibility.
You can not have every team member working on all parts of the project.
Then each person has a part of the project as a separate file. The more

people you have on a project the more files you need.

In this example we have several people actively working on the project. As
I noted earlier the first step is to sort out the responsibilities. This project
is a single large building. You could divide up the project in several ways,
either by zone, or by stories of the building, or by building elements. Each
way of dividing up the building will change the file structure.

For this example 1 will divide the project in areas of responsibility based
mainly on the building elements:

e Architect 1 - Base drawing, walls, doors and windows, columns and
grid

e Architect 2 - Floor Finishes and floor detailing

e Architect 3 - Ceiling, lighting and ceiling details

e Architect 4 - Site Plan

e Architect 5 - Sections

e Architect 6 - Elevations

e Architect 7 - Drawing output (printing)

©Jonathan Pickup - http://www.archoncad.com Page 29
SHORT SHARP TRAINING - Issue 1206


http://learn.archoncad.com/?p=4887

Site Plan

Now that the project is broken up we can start to set up the files. We could
start with the site plan or the base plan. We want to separate the site plan
and the base plan so we can have two people working.

The site plan needs to have a survey file imported, so organise the surveyor.
Whilst you wait for that file you could start the base drawing.

Your surveyor may not have Vectorworks, so you should expect to import
a DXF/DWG file into your site plan. Remember, when you import a DXF/
DWG file you should be importing it into a completely new file, do not
import it into your existing base plan.

When the survey plan has been imported, and checked for size and scale, it
should be saved. It can then be linked to the base plan and the other draw-
ings.

Here is the conceptual sketch.
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e 1
i g+ s, b .

After the base drawing has been started, you can link it to the site plan, to
check site coverage, boundaries, drains and so on, using a Design Layer
Viewport.

* Go to the Menu bar.

* Choose View > Create Viewport...

Zoom

Class Qptions
Layer Options
Standard Views
Projection
Rendering
Renderworks Style
Perspective
Lighting

YYYYYVYYYY

Look at Working Plane
Set Renderworks Background...

Set 3D View #*0
Rotate 3D View...
Rotate Plan

Align Layer Views
Unified View L
Unified View Options...

Create Section Viewport...

Update All Viewports

* Type in the Viewport Name. If you have several reference files, a
concise viewport name will help you to locate this design layer viewport.
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You do not need to enter a drawing title for this viewport.

* Choose the design layer you want to place this viewport on.

Create Viewport

Viewport Name:  Linkto base plan
Drawing Title [Drawing Title]

Create on Layer: | 001_b

Source: Current Document

Select Source...
Layers...

[V Display Planar Objects
IET Praject Screen Objects

Classes...

Scale: 1:5000

* Click on the Select Source... button. This is to choose your reference
file

Create Viewport

Viewport Name: | Link to base plan|

Drawing Title: [Drawing Title]

ar

Create on Layer: | 001_b

Source: Current Document

[ SaleckS 1kj

Layers...

E]Displav Planar Objects
@Project Screen Objects

Classes...

Scale: 1:5000

Customn Scale 1: 500«

View: Top/Plan

* You can choose a layer from the current, or from an external document,
as a reference.

¢ (Click on External Document.

 If it is not already selected, click on New Reference.
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¢ (Click on the Choose... button

Select Viewport Source

Source File
Current Document
(=) External Document
Existing Reference
(=) New Reference | Clvu)mm..fk 4

No File Selected

Save reference location as:

Absolute Path
Path relative to current document

Automatically update out of date reference during file open
Save referenced cache to disk

 this button to specify the external document from which to create the viewport

Cancel | | OK |

* Locate the file you want to reference.

o Open Current-Version Drawing
] = @ | | (11206 Referencing ) (@
FAVORITES
SHARED
DEVICES
1206_building wx 1206_site. vwx
e
1206.vwx Base Plan.vwx. Celing vwx
Cancel | | Gnen‘rj

* Double-click on the new file that you want to reference, or click on the
file once and then click on the Open button.

* If you have saved Vectorworks your file and your PDF is in the same
folder as your Vectorworks file (recommended), then choose Path
relative to current document. Otherwise, choose Absolute path.
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Select Viewport Source

Source File
Current Document
() External Document
Existing Reference
(3) New Reference Chaose...

-:Base Plan.vwx

Save reference location as:

Absolute Path
() Path relative to current document

Automatically update out of date reference during file open
Save referenced cache to disk

The full pathaame t the source document.

Cancel | [ OK

* Click on the OK button.
This takes you back to the Create Viewport dialog box.

e Click on the Layers... button.

Create Viewport

Viewport Name:  Link to base plan
Drawing Title: [Drawing Title]

Create on Layer: 001_b

Source: Base Plan.vwx

Select Source...

| Layers... Y

|21 Display Planar Objects
(¥ Project Screen Objects

Classes...
Scale: 1:5000
Custom Scale 1:
View: Top/Plan

* Check the layers that are available from your reference file. Click in the
visible column for the layers you want to see, click in the invisible
column for the layers you do not want to see.
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Viewport Layer Properties

Viewport: Link to base plan

Vis Layer
*  Root-3
®  Floor-2

© Floor-1

0K

Cancel

* Click on the OK button to return to the Create Viewport dialog box.

* You can also click on the Classes... button to change the visibility of
classes in your viewport.

The visibility of layers and classes in your design layer viewport can be
changed at any time by using the Layers... and the Classes... buttons on
the Object Info palette.
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Create Viewport

Viewport Name Link to base plan
Drawing Title [Drawing Title]

Create on Layer: 001_b =

Source: Base Plan.vwx

Select Source...
Layers...

IZT Display Planar Objects
™ Project Screen Objects

Classes...
Scale: 1:5000
Custom Scale 1:
View: Top/Plan
Rendering Wireframe

RW Background None
Projection: 2D Plan
Perspective Type: Normal

Perspective Dist

Oick OK to accept changes and dismiss dialog.

Cancel OK
ok

* Click on the OK button to finish creating your viewport.

The viewport will not arrive in the correct location on the site, so you have
to move it. You might also notice that the orientation of the viewport does
not line up with the site plan. The advantage of using a Design Layer
Viewport to reference your other file is that you can then rotate the design
layer viewport and move it to fit the site.
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* You will find it easier if you zoom in.

e Make sure you use something that you know lines up between the
floorplan and the site plan.
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Object

Eaa

* The Design Layer Viewport can be rotated without affecting the
original file.

e This allows the other architects to draw the building orthogonally, while
the site plan shows the building correctly located.

In the image below you can see that the plan of the building is too big for
the site.
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If another user opens up the floor plan file, it can be edited at the same time
that the site plan is being worked on. This is what makes referencing so
powerful, allowing several users to work on the same project at the same
time.

* The floor plan can be updated by another architect to suit the site
conditions.

* The revised file must be saved before it can be updated on the site plan.
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» After the revised floor plan has been saved, the referenced file will be
shown in the Navigation palette as Out of date.

8.0 Navigation - References
a = [=] & L+
o & B EBED

Referenced File | File Type & | Status
Base Plan.wwx Vectorworks  Out of date

» Right-click on the referenced file and choose Update.
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Mavigation - References

{0 | & E BB
Referenced File | File Type &  Status

Base Plan.w Out of date
New...

Edit...
Delete...

Update®all

Open

Details...

Select All

The site plan will now show the most up-to-date information from the floor
plan file.
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Base Plan

The base drawing will control the setting out of the project e.g. the overall
grid, walls, doors and windows and any structural components. It is impor-
tant that the layers and classes follow an agreed system or standard. An
agreed system will make it easier for everyone working on the project.

The base plan may not have references from other parts of the project, but
it will certainly be referenced to many other parts. The base plan should be
carefully structured so that it uses classes, layers, and stories correctly.

Use the organization dialog box to set up the layers and stories for the
project.

() Details Visibilities

| Classes [0 20| Stories  Sheetlayers  Viewports  Saved Views References |

Visibility Design Layer Name # & scale Story Level Type Elevation
] Roof-3 1 1500 Story-2 Roof 3500
© Floor-2 2 1:500 Story-2 Finish Fl. 3500
L] v Floor-1 3 1:500 Story-1 Finish Fl 0

New... Edit... Duplicate Delete... Preview Level Types... Page Setup...

Cancel | [ OK

When the building grid is correctly drawn, the base drawing can be refer-
enced to the site plan.
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As the base plan develops, the site plan just needs to have its reference
updated for it to show the latest information.

©Jonathan Pickup - http://www, .archoncad .com Page 43
SSSSSSSSSSSSSSSSSSSSSSSSSSS



Ceilings and Floor Finishes

The next step is to start the Ceiling and Finished Floor Drawings. These
drawings may be in the same file but they could easily be separated and
have one file for the ceiling drawings and one file for the floor finishes. The
structure is the same in either case.

Here is the conceptual sketch.

For the site plan Design Layer Viewport Referencing technique was
used, which allows the relocation and rotation of the floor plan to suit the
site. For the next stage of the works you want to make sure that your
ceiling and floor finish drawings line up exactly with the base plan. For this
reason you will not be using viewport referencing, use Layer Referencing.

* Go to the Menu bar.
* Choose Tools > Organization...

* Click on the Settings... button.
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Qrganization

@ & File Name File Type Status.

New...

Ouptays the Refareace Settngs dalog

Classes  Design Layers  Stories  Sheet Layers  Viewports

#) Derails Visibilities
Saved Views [T

Save Cathe

| Settingg.. |

Cancel

oK

* Click on Layer import.
* Click on the OK button.

Reference Settings

These settings apply to all references.

IET Use reference priority when updating resources

When manually updating
Only update out of date references

Use this method to reference Vectorworks files:
Design layer viewports
(») Layer import
- L3

Cancel

[ Check for out of date references every 120 | minutes

w_f_-Kefresh references even if they appear to be up to date

OK

¢ (Click on the New... button to create a new reference.

Qrganization

& & File Name File Type Status.

.E

Creates & new reference.

Classes  Design Layers  Stories  Sheet Layers  Viewports

#) Derails Visibilities
Saved Views [T

Save Cathe

Settings

Cancel

oK

* Locate the file you want to reference.
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o Open File
i = | [ (31206 Referencing BICY
: [csss N |
SHARED ID
DEVICES
1206 Base Plan.vwox 1206 Celing.vwx 1206 Creating Vectorworks
R References.indd
—
1206 Floor Finishes.vwx 1206 Site Plan.vwx imageao1.png
=~
R
Cancel | [ Open |

* Double-click on the new file that you want to reference, or click on the
file once and then click on the Open button.

 If you have saved your file, and your source file is in the same folder as
your Vectorworks file (recommended), then choose Path relative to
current document. Otherwise, choose Absolute path.

* Click on the layers that you want to use.
* Click on the OK button.

New Reference

Source File

.:1206 Base Plan.vwx

Save reference location as:

Absolute path
(=) Path relative to current document

Layers Available

Layer

Roof-3
v Floor-2
v Floor-1

Checked layers are referenced. Resources may be
referenced through the Resource Browser.
Options
Save referenced cache to disk
Automatically update out of date reference during file open
Update class definitions
Ignore source user origin

Create layer link(s) on layer: Ground Floor Ce

Cancel | [ OK

* Click on the Design Layers tab to see the referenced layers. Notice that
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the referenced layers are shown in italics.

Qrganization

) Details Visibilities

Classes ETTIETITH Stories  SheetLayers  Viewports | Saved Views  References

Visibiliy | Design Layer Name & s scale Story Level Type Elevation

© Ground Hoor Ceiling-2 11500 o

- ¥ Ground Flaor Ceiling 2 1500 o

® Floor-2 3 1500 Finish Fl.. 3500

® Fioar-1 4 1500 Finish Fl.. 0
[

New... Edit... Duplicate Delete... Preview Level Types... Page Setup...

Lts the Gosument’s Geuan layers and thex attobutis.

Cancel | [ OK |

The referenced layers can be turned on and off and the Layer Options can
be changed like any other layer.

Organization
) Details Visibilities
[N Design L Stories  SheetLayers  Viewports | Saved Views  References
Visiility | Design Layer Name ook scale Story Level Type Elevation
* Ground Floor Celling-2 1 1500 o
« ¥ Ground Floor Ceiling 2 1500 a
< Fioer-2 3 1500 Finien Fl. 3500
® Fioar-1 4 1500 Finish Fl. o
New. Edit. Duplicate Delete Preview Level Types... Page Setup...
Cancel | [FEOK]

* Click on the OK button to close the Organization dialog box.

The ceiling and floor drawings can be drawn on the correct layers,
snapping to the referenced layers.

©Jonathan Pickup - http://www.archoncad.com Page 47
SHORT SHARP TRAINING - Issue 1206



©Jonathan Pickup - http://www.archoncad.com Page 48
SHORT SHARP TRAINING - Issue 1206



Sections and Elevations

The next stage might be the sections and elevations. The sections need the
ceiling plans and maybe the floor plans as well as the base plans. These
should be referenced to the section and elevation files as we did for the
ceiling and floor files.

Here is the conceptual sketch.

Floens .
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Printing

Documentation is the last stage. One way of completing the documentation
is to reference all the other files to a contact document file. You could then
have one person who would be responsible for making sure the drawings
are in order, complete, correctly annotated, dimensioned, referenced and so
on.

Reasons to keep all the drawings in one file:

- you can batch print the drawings from one file
- you can batch PDF the drawings from one file
- you can control all the revisions from one file
- you can control drawing issues more easily.
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When you create a Reference in Vectorworks 12 you copy the complete
layer from the source file to the target file. In a project like this, you might
have hundreds of layers in the contract documentation file. In Vectorworks
12 this will make the file huge.

When you create a Reference in Vectorworks 2008 and beyond you can
choose to not copy the complete layer, instead you can choose to reference
it. This will make the contract documentation file much smaller and easier
to manage.

The Vectorworks Architect version for Austraiia and New Zealand offers
a useful tool for drawing borders, called the VAA Title Block. This tool
is more useful than the standard Vectorworks Drawing border. It allows
you to add revisions and issues to selected drawings, you can batch print
drawings and you can customise your title block symbols. But the best part
of this tool is the ability to create a Document Transmittal form. This will
list all the drawings, the revision, who you issued the drawings to and when
the drawings were issued. At the end of the project you have a complete list
of all the drawing issues.

The example I have used allows seven people to work on this one project.
Any alterations on the base plan will be shown on the floor and ceiling
drawings and documentation. Any changes to the sections, elevations or the
other files will update in the documentation file as well.
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Landscape Examples

In this example we have a landscape plan. We want this to tie in to the
overall site plan. The challenge is that the architect and road engineer keep
making changes to the plans. If you import the drawings from the architect,
then complete your planting and hardscaping, how can you make sure that
you are working on the current file?
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Working with Shapefiles

Import the drawing and check it for accuracy. Then reference the imported
drawing into your project.

When you get a revised drawing, import it into the referenced document
and save it.

When you open your drawings, you will see the new work. This will allow
you to easily update your drawings.

-

DLVP
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Working with DXF/DWG Files

Import the drawing from the consultant. Check it for accuracy. Then refer-
ence the consultant drawing to your project.

When you get a revised drawing, import it into a new document and save
it with the same name as the old consultant’s drawing, overwriting the old
file.

When you open your drawings, you will see the new work from the consul-
tant. This will allow you to easily update your drawings.

B L

- | mprie/A
A, Ot /pre
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Subdivision Drawing

In this example you might have more than one designer working on the
project.

You might divide the file into three or four files, and reference these files to
the master plan to create the complete project.
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Thank you

We trust that you have enjoyed working through this manual and that it has
been informative and constructive.

For more information, please visit: http://www.archoncad.co.nz/. If you
Jjust want someone to help you learn Vectorworks, to carry out some Vec-
torworks contract work, or you want someone to make Vectorworks easier,
contact us, as this is a service that we also offer:

jon@archoncad.co.nz.

Thank you again,
Jonathan Pickup
June 2012
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